COMPUTATIONAL ANTIVIRAL DRUG DESIGN

A THESIS

SUBMITTED TO THE GRADUATE SCHOOL

IN PARTIAL FULFILLMENT OF THE REQUIREMENTS

FOR THE DEGREE

MASTER OF SCIENCE

BY

HEATHER ANN CLIFTON

DR. JASON W RIBBLETT

BALL STATE UNIVERSITY

MUNCIE, INDIANA

JULY 2009
ACKNOWLEDGEMENTS

I would like to extend a heartfelt thanks to everyone who supported me during my academic years. I never would have made it this far without your love, support and confidence in me.

To Jeremy and Madyson Clifton: you are my guiding light. Without your support I never would have believed in myself enough to pursue an advanced degree. Madyson, you are the driving force behind all I do in hopes of giving you the life you deserve.

To my parents, Kevin and Lorene Solace: you have been there for me throughout all the ups and downs of childhood and adolescence. You taught me to always do my best and never give up, even when things are difficult. I know you have always supported me are proud of my accomplishments.

To my grandmothers, Dolores Solace and Tip Schneider: you were there for me a lot during my childhood, and I appreciate the time we were able to spend together. You both also have been there to support me as an adult. I know this is rare and I am grateful for the close relationship I am able to have with you both.

To my advisor, Jason Ribblett: thank you for giving me the opportunity to complete this research. You have been a great mentor and advisor for me through the last years of my college career. I can count on you to be honest with me.

To my other committee members, James Poole and Scott Pattison: thank you for your time and support of this research and thesis work, as well as throughout my time as a student at Ball State.
Twenty-five ligands were designed and evaluated as inhibitors of influenza neuraminidase. Optimized geometries of the twenty-five ligands were determined using B3LYP/6-311++G** techniques. Docked energies of the ligands bound to the N4 subtype of the neuraminidase protein were determined using AutoDock 4.0. Although all twenty-five ligands in this study exhibited a tendency to bind in the same pocket of the N4 protein, the 5_nitrogen2 ligand returned the most stable average docked energy of −7.1 kcal mol$^{-1}$. Its potential as a neuraminidase inhibitor is discussed.
CONTENTS

Chapter 1: Introduction and Literature Review

1.1 Influenza: Information, Biological Activity, Current Options ..................... 1
1.2 Computational Chemistry: Methods and Uses in Drug Discovery .................. 3
1.3 References .................................................................................................... 7

Chapter 2: Procedure

2.1 Ligand Development .................................................................................... 8
2.2 Gaussian Procedure and Theory................................................................... 14
2.3 Protein Selection ........................................................................................ 15
2.4 AutoDock Procedure and Theory................................................................. 16
2.5 References .................................................................................................. 19

Chapter 3: Results and Conclusion

3.1 Docking ....................................................................................................... 21
3.2 Ligand Energy Ranking ............................................................................... 22
3.3 Confirmed Antiviral Activity ...................................................................... 23
3.4 5-hydroxy Results ..................................................................................... 24
3.5 Conclusion.................................................................................................. 29
3.6 References .................................................................................................. 30

Appendix A: Building a Molecule in GaussView ............................................. 31
Appendix B: Setting Calculation Parameters..................................................... 32
Appendix C: Transferring Files to the Cluster Using WinSCP ......................... 34
Appendix D: Using PuTTY to Access the Cluster ............................................. 36
Appendix E: Transferring Files to the PC Using WinSCP .................................. 38
Appendix F: Opening an Output File in GaussView ........................................39
Appendix G: Preparing a Ligand for AutoDock ...........................................41
Appendix H: Preparing a PDB file for AutoDock .........................................42
Appendix I: Running AutoGrid ................................................................44
Appendix J: Running AutoDock ................................................................46
Appendix K: Analyzing Docking Results .......................................................47
Appendix L: Images of Dockings .................................................................50
LIST OF TABLES

Table 2.1. Ligand Examples: Six-Membered Ring Substitutions..........................11
Table 2.2. Ligand Examples: Five-Membered Ring Substitutions.........................12
Table 2.3. Ligand Examples: Six-Membered In-Ring Substitutions.......................13
Table 2.4. Ligand Examples: Five-Membered In-Ring Substitutions.....................14
Table 3.1. Ligands Ranked by Increasing Docked Energy..................................22
LIST OF FIGURES

Figure 2.1. Zanamivir and Oseltamivir.................................................................9
Figure 2.2. Basic Structures..................................................................................10
Figure 2.3. 2HTV..................................................................................................16
Figure 3.1. 5_hydroxy Docked with N4 Protein..................................................24
Figure 3.2. 5_hydroxy Docked with Space Fill Ligand.......................................25
Figure 3.3. Clustering Energy of 5_hydroxy.......................................................27
Figure 3.4. 5_hydroxy Close-Up Docking with Ball and Stick Mod....................28
Figure 3.5. 5_hydroxy Close-Up Docking with Space Fill Model.......................29
Figure A.1. Building a Molecule in GaussView.................................................31
Figure B.1. Gaussian Calculations.......................................................................33
Figure B.2. Saving a Molecule in GaussView....................................................33
Figure C.1. Opening WinSCP.............................................................................34
Figure C.2. Transferring to Cluster using WinSCP............................................35
Figure D.1. Opening PuTTY................................................................................36
Figure D.2. Converting from dos to unix using PuTTY.......................................37
Figure D.3. Submitting calculations using PuTTY...............................................37
Figure E.1. Transferring to Computer using WinSCP.........................................38
Figure F.1. Opening an Output File in GaussView............................................39
Figure F.2. Saving a .mol2 file in GaussView....................................................40
Figure G.1. Ligand root.......................................................................................41
Figure H.1. Removing water from macromolecule............................................43
Figure H.2. Saving PDB file................................................................................43
Figure I.1. Grid box...........................................................................................................45
Figure K.1. Conformation Chooser..................................................................................47
Figure K.2.Docked Ligand.................................................................................................48
Figure K.3. Dockings shown as spheres............................................................................48
Figure K.4. Interactions between docking site and ligand..............................................49
Figure L.1. Interaction between protein and 2_nitrogen5 ligand.................................50
Figure L.2. Interaction between protein and 2_oxygen ligand........................................51
Figure L.3. Interaction between protein and 2_methyl ligand........................................52
Figure L.4. Interaction between protein and 5_hydroxy ligand.......................................53
Figure L.5. Interaction between protein and 2_oxygen5 ligand.....................................54
Figure L.6. Interaction between protein and 6_methyl ligand.........................................55
Figure L.7. Interaction between protein and 2_hydroxy5 ligand.....................................56
Figure L.8. Interaction between protein and 5_chloro ligand..........................................57
Figure L.9. Interaction between protein and 5_methyl ligand.........................................58
Figure L.10. Interaction between protein and 2_nitrogen ligand....................................59
Figure L.11. Interaction between protein and 6_chloro ligand.......................................60
Figure L.12. Interaction between protein and 5_oxygen ligand......................................61
Figure L.13. Interaction between protein and 5chloro_5 ligand......................................62
Figure L.14. Interaction between protein and 6_oxygen ligand.......................................63
Figure L.15. Interaction between protein and 6_nitrogen ligand....................................64
Figure L.16. Interaction between protein and 5_nitrogen5 ligand....................................65
Figure L.17. Interaction between protein and m2_methyl5 ligand.................................66
Figure L.18. Interaction between protein and m5_oxygen5 ligand.................................67
Figure L.19. Interaction between protein and m2_chloro5 ligand..................68
Figure L.20. Interaction between protein and m2_chloro ligand..................69
Figure L.21. Interaction between protein and m5_hydroxy5 ligand..............70
Figure L.22. Interaction between protein and m5_methyl5 ligand...............71
Figure L.23. Interaction between protein and m6_hydroxy ligand.............72
Figure L.24. Interaction between protein and 5_nitrogen ligand...............73
Figure L.25. Interaction between protein and m2_hydroxy ligand.............74
Chapter 1: Introduction and Literature Review

1.1 Influenza: Information, Biological Activity, and Current Options

Influenza is a serious problem in the medical community. Each year in the United States, roughly 200,000 individuals are hospitalized due to influenza. Additionally, on average 36,000 deaths are attributed to influenza yearly in the US.\textsuperscript{1} Children and elderly are more susceptible to have serious complications from influenza.

There are two types of influenza, A and B, with hundreds of strains of each. Influenza A is generally considered to be the more prevalent and dangerous type, as it is usually associated with epidemics. Influenza is an evolving virus, constantly reproducing new mutant strains resistant to treatment.\textsuperscript{2} The influenza virus is a segmented, membrane-enclosed, negative-strand RNA virus.\textsuperscript{3} The influenza viral protein membrane is made up of three main components: hemagglutinin (HA), the M2 proton channel, and neuraminidase (NA). There are sixteen subtypes of hemagglutinin, HA: H1-H16. Hemagglutinin is involved in the attachment to sialic acid, which is a receptor on the target cell surface. The hemagglutinin allows binding onto and consequently penetration of the virus into the target cell.\textsuperscript{4}
The M2 proton channel functions as an ion channel which regulates the internal pH of the virus. The M2 channel plays a fundamental role in the viral entry process by endocytotic uptake. The M2 channel is activated in the acidifying endosome which allows hydrogen ions to pass into the virus interior. The resulting acidification of the virus releases the viral RNA from its matrix, allowing it to infect the target cell.5

Neuraminidase is responsible for the spread of the virus. There are nine subtypes of neuraminidase, NA: N1-N9. After the virus has replicated within the target cell, the neuraminidase cleaves the terminal sialic acid from the receptor, allowing the newly formed virus to be released and infect other cells.3 Each of the three components are important in the replication and spread of influenza throughout the body, but if just one segment of the cycle can be stopped, influenza could be more easily controlled.

Currently, there are few options for the prevention or treatment of influenza. Vaccines are typically readily available for prevention; however, many people who are at-risk do not take advantage of this form of prevention. There are four pharmaceutical products currently approved by the FDA available for the treatment or prevention of influenza, which include two different types: ion channel blockers and neuraminidase inhibitors. These drugs are approved for either treatment or prevention if it is almost certain the patient will contract the virus.

Amantadine and Rimantadine are two ion channel blocking drugs. They function by blocking an ion channel in the M2 protein of the viral membrane. The drugs prohibit the entrance of hydrogen ions through the membrane, which in turn
prevents replication. Amantadine and Rimantadine reduce and shorten the symptoms of influenza A if given to patients within 48 hours of the emergence of symptoms. Oseltamivir and Zanamivir are two neuraminidase inhibitors. They are effective because they inhibit the production of neuraminidase, preventing the virus from penetrating the cell surface, and thus preventing infection. Oseltamivir and Zanamivir are effective in reducing symptoms for both influenza A and B when given to patients who are symptomatic for less than two days.

Clearly, there is an enormous need for a practical approach to the treatment of influenza. The goal of this research is to design a new antiviral drug which is effective against both influenza A and B. The ideal drug should have minimal side effects and fewer restraints than the current drugs on the market. The purpose of this thesis is to present my research procedure, difficulties which were overcome, and resulting information.

1.2 Computational Chemistry: Methods and Uses in Drug Discovery

Computational chemistry is a diverse branch in the area of chemistry. Computers can be used to model the inner workings of atoms, the relationships between atoms in molecules, and the interactions between molecules. Computational chemistry can be used to investigate concepts such as molecular geometry; energies of molecules and transition states; reactivity; physical properties; IR, UV and NMR spectra prediction and the interaction of a substrate with an enzyme.

Two computational methods are \textit{ab initio}, and semi-empirical. \textit{Ab initio} calculations are based upon approximations of the Schrödinger equation, which
results in the molecules’ energy and wave function. Semi-empirical (SE) calculations also are based on the Schrödinger equation, but more approximations are made and the integrals used are based from empirical research. Semi-empirical methods can be broken down into subtypes, including molecular mechanics (MM) and density functional theory (DFT). MM is based on a ball and spring model of molecules. DFT is also based on the Schrödinger equation; however, a wave function is not calculated. Instead, an electron distribution is derived.\(^8\) Density functional theory is a method of computational analysis which is based on the electron probability density function. This function is commonly referred to as electron density or charge density. It is a measurement of the probability of finding an electron within a set volume. Electron density is the basis of many methods, including DFT, of studying atoms and molecules. Electron density is a desirable quality to study as it is a measurable value and can readily be experimentally observed; whereas, wave functions are immeasurable. A second benefit of electron density is that it is a function of position, leaving it with only three variables (x, y, z); whereas, a wave function of an \(n\)-electron molecule is a function of \(4n\) variables. A main benefit of DFT calculations is the short amount of time needed to return calculations with high quality results.\(^9\)

Computational chemistry has been especially useful in the area of drug discovery. The idea of structure based drug discovery was first envisioned when protein structures were able to be determined experimentally. An early realization in computer based drug design was that rigidity of a receptor affected the binding interactions of a substrate. The conformational flexibility of both the target and the receptor plays a role in the ability of the two to interact and bind together. More
accurate results can be obtained by incorporating a range of side-chain rotamers for a small number of active-site residues in the target molecule. Allowing for a variety of conformations accounts for any changes in target conformation upon complex formation. 9

This information led to new developments and methods in structure-based drug design methods. One such method is fragment-based design. When using this method, molecular fragments are tested using a docking program to discover fragments that may bind to an active site. These promising fragments are then expanded by adding groups or combining multiple fragments to enhance binding from the weakly bound small molecules into a larger fragment. This method can be beneficial due to a higher hit rate for the smaller fragments. However, the binding of the inhibitor does not always duplicate the binding of fragments, leaving fragment-based design as a complementary process to classical approaches. 9

A second method involves identifying drug target sites on a protein. The active sites on a protein that seem as if they should have binding abilities are targeted based upon their biological activity. Once these potential active sites are located, usually via pocket detection, a suitable ligand can be created in an attempt to satisfy the binding requirements. This will not always prove to be useful, as the pockets detected may be biologically inactive or the most favored target site may be missed by the detection. 9

Protein-protein interactions are another avenue for drug discovery. This method gives a larger contact area, but binding contributions are not evenly distributed along the surface, resulting in some locations having a higher focus of
attractability. The protein-protein system has multiple solutions to binding and adaptations at the focal points, due to flexibility within the proteins. Most small molecule modulators have not been found using this method.⁹

A final method is by means of computational docking to nominated protein sites. The work to fulfill this research project most closely resembles this method. Computational docking is a more effective method of performing a virtual screening of a collection of ligands to find a compound which matches the target site. Molecular dynamics can be paired with docking to more accurately fit small molecules into protein binding sites. Molecular dynamics simulations can be used for four tasks: optimizing the structure and flexibility of a protein structure, refining docked complexes to account for solvent effects, calculating binding energies to accurately rank the potential ligands, and finding the binding site during the docking process.⁹

This final approach is termed blind docking, in which the active site of the protein does not need to be known, but rather the entire surface of the protein can be analyzed for potential docking sites. This can be beneficial if the active site of a protein is unknown, as well as for a more broad analysis of a protein.

Computational drug discovery has made great leaps in the last decade, resulting in the ability to scan a large library of potential ligands for a specific protein in a relatively fast and easy manner, in contrast to actual synthesis of every ligand to be tested. Computational work is a cost effective alternative for pharmaceutical research, from both a time and money perspective. Computational drug discovery has opened the door for much more testing for a wider range of disorders which may have otherwise gone untouched due to the considerable time involved and the high cost of
traditional synthetic approaches. Another major benefit of computational screening for potential drug leads is the lessened impact on the environment. Using computational methods will narrow the possibilities of drug leads resulting in reducing the synthesis and testing of a large number of compounds to a more select list. Once a smaller number of promising ligands has been established, synthesis and testing can commence, but the amount of chemical waste will have been greatly reduced, due to the elimination of unnecessary production.

1.4 References

Chapter 2: Procedure

2.1 Ligand Development

In completing this computational research, many steps were involved. This section briefly describes the methods employed during this research. A very detailed user’s manual including tables and illustrations can be found in Appendices A through K.

The research divides itself into two sections. The first part involves creating the molecule of interest, performing optimization calculations in a variety of ways, reviewing the resulting file and finally converting the file to the appropriate format for use in the second part. Four programs are utilized during the first part: GaussView\textsuperscript{1}, Gaussian\textsuperscript{2}, WinSCP\textsuperscript{3} and PuTTY\textsuperscript{4}. With the exception of Gaussian, the first part is performed using a Windows platform. Gaussian is run on the College of Sciences and Humanities Cluster (cluster).

An important step in this work was to identify a molecule of interest for docking, the ligand. Each protein active site has a unique size and shape which determines the complexity, and size and shape of a binding ligand. Because the size and shape of an active site are biologically determined, the substrate dictates the size,
shape and chemical make-up of a target site. This relationship determines the complementary size, shape and complexity of possible ligands. For this research twenty-five ligands were created, based upon analysis of two previously FDA approved influenza medications, Relenza (Zanamivir) and Tamiflu (Oseltamivir). (See Figure 2.1)

![Figure 2.1: Zanamivir (left) and Oseltamivir (right).](image)

Similarities in these two molecules were identified. They include: a six-membered ring, possibly containing one double bond or a hetero-atom; a carbonyl or carboxyl group adjacent to the double bond or heteroatom; an amino group in the 3-position on the ring relative to the carbonyl or carboxyl group position; and an amide group in the 4-position on the ring and in an anti-configuration relative to the amino group. The similarities were combined into two new molecules, which will be referred to as the basic structures. (See Figure 2.2) After finding the basic structure with the six-membered ring, a second basic structure was created using a five-membered ring even though neither Zanamivir nor Oseltamivir contain five-membered rings. The five-membered ring structure was created to investigate the dependence of ligand-protein complexation on ring-size.
A library of ligands was then created using these two basic structures. For the first modification to the basic structure, different substitutions were made at the 2-, 5-, or 6- position on the six-membered ring (See Table 2.1) or the 2- or 5- position on the five-membered ring. (See Table 2.2) The three substituents were a methyl group, a chloro group, and a hydroxyl group. The second modification involved changing one of the carbon atoms within the ring. Again, the substitutions happened at the 2-, 5-, or 6- position (See Table 2.3) or 2- or 5- position (See Table 2.4), depending on the ring size. For example, the carbon atom at the 2-, 5- or 6- position on the six-membered ring was exchanged for a nitrogen or oxygen atom. These modifications resulted in a total of twenty-five ligands to test. These ligands were named using a format of the position of the substitution followed by the type of substitution. For example, the ligand named 2_methyl would have a methyl group substituted at the 2-position on the six-membered ring. The ligand named 5_oxygen5 would have an oxygen atom substituted into the ring at the five position on the five-membered ring. These ligands were then built and optimized using Gaussian.²
Table 2.1: Ligand Examples: Six-membered Ring Substitutions

<table>
<thead>
<tr>
<th>Substitution at 2-position</th>
<th>2_methyl</th>
<th>2_chloro</th>
<th>2_hydroxy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="2-methyl substitution" /></td>
<td><img src="image" alt="2-chloro substitution" /></td>
<td><img src="image" alt="2-hydroxy substitution" /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Substitution at the 5-position</th>
<th>5_methyl</th>
<th>5_chloro</th>
<th>5_hydroxy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="5-methyl substitution" /></td>
<td><img src="image" alt="5-chloro substitution" /></td>
<td><img src="image" alt="5-hydroxy substitution" /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Substitution at 6-position</th>
<th>6_methyl</th>
<th>6_chloro</th>
<th>6_hydroxy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="6-methyl substitution" /></td>
<td><img src="image" alt="6-chloro substitution" /></td>
<td><img src="image" alt="6-hydroxy substitution" /></td>
<td></td>
</tr>
</tbody>
</table>
**Table 2.2: Ligand Examples: Five-membered Ring Substitutions**

<table>
<thead>
<tr>
<th>Substitution at the 2-position</th>
<th>2_methyl5</th>
<th>2_chloro5</th>
<th>2_hydroxy5</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="2_methyl5" /></td>
<td><img src="image2" alt="2_chloro5" /></td>
<td><img src="image3" alt="2_hydroxy5" /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Substitution at the 5-position</th>
<th>5_methyl5</th>
<th>5_chloro5</th>
<th>5_hydroxy5</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4" alt="5_methyl5" /></td>
<td><img src="image5" alt="5_chloro5" /></td>
<td><img src="image6" alt="5_hydroxy5" /></td>
<td></td>
</tr>
</tbody>
</table>
Table 2.3: Ligand Examples: Six-membered In-Ring Substitutions

<table>
<thead>
<tr>
<th>Substitution at 2-position</th>
</tr>
</thead>
<tbody>
<tr>
<td>COOH</td>
</tr>
<tr>
<td><img src="image" alt="2_nitrogen" /></td>
</tr>
<tr>
<td>2_nitrogen</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Substitution at the 5-position</th>
</tr>
</thead>
<tbody>
<tr>
<td>COOH</td>
</tr>
<tr>
<td><img src="image" alt="5_nitrogen" /></td>
</tr>
<tr>
<td>5_nitrogen</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Substitution at the 6-position</th>
</tr>
</thead>
<tbody>
<tr>
<td>COOH</td>
</tr>
<tr>
<td><img src="image" alt="6_nitrogen" /></td>
</tr>
<tr>
<td>6_nitrogen</td>
</tr>
</tbody>
</table>
Table 2.4: Ligand Examples: Five-membered In-Ring Substitutions

<table>
<thead>
<tr>
<th>Substitution at the 2-position</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="2_nitrogen5" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Substitution at the 5-position</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="5_nitrogen5" /></td>
</tr>
</tbody>
</table>

2.2 Gaussian Procedure and Theory

Gaussian is an electronic structure modeling program. It follows the basic laws of quantum mechanics when predicting energies, molecular structures and vibrational frequencies of systems. GaussianView is the graphical user interface employed by the program to allow the user to build a structure and see a visual representation of the output file.
Geometry optimization calculations were performed for each ligands using B3LYP/6-311++G** techniques. For this research, all calculations were performed under the following specifications: the job type was set to optimization; method was set to ground state using DFT/B3LYP with the basis set to 6-311++G**. This basis set allows a higher level of valence shell splitting to be possible. 6-311++G** basis sets represent inner-shell atomic orbitals (core) in terms of six Gaussians; however, the valence functions are split into three parts instead of two. This splitting results in a three-one-one configuration. The ++ designation allows the basis set to be supplemented by diffuse functions. Both hydrogen and heavy atoms are provide s and p-type diffuse functions. The ** designation represents polarization functions, which allow orbitals to take on an asymmetric nature by including d-orbitals on heavy atoms and for p-orbitals on hydrogen atoms. These calculations were performed on the cluster. Gaussian jobs were parallelized using Linda software. Output geometry files were converted to .mol2 format for use in AutoDock. For a detailed discussion regarding the procedure used in the preceding steps, please see appendices A-F.

2.3 Protein Selection

Prior to ligand development, the protein target was first selected. For this research, the neuraminidase subtype N4 (PDB ID 2HTV) was chosen for study. (See Figure 2.3) It is structurally similar to N1 neuraminidase, but has had fewer investigations involving antiviral activity. Its structure was initially released on September 9, 2005, but last modified on February 24, 2009. It is a strain of influenza A virus. It consists of two polypeptide chains and is classified as a hydrolase.
Figure 2.3: Visualization of 2HTV, N4 neuraminidase

Structural comparison of N1, N4 and N8 Group-1 neuraminidase shows their active sites to be virtually identical. Group-1 NAs consist of N1, N4, N5, and N8. Group-2 contains N2, N3, N6, N7 and N9. There are conformational differences between Group-1 and Group-2 NAs. These differences come in the form of various amino acid configurations. The differences result in a large cavity being present in Group-1 NAs which is not available in Group-2 NAs.9

2.4 AutoDock Procedure and Theory

The second section of the research utilized AutoDock 4.110 which was run using a Linux platform, Ubuntu. AutoDock 4.1 functions on the docking simulation method of automated docking. It employs a more physically detailed docking technique that can incorporate flexible docking. AutoDock 4.1 gives good results when predicting rankings for a series of similar molecules.10,11 It contains a suite of automated docking tools. Its purpose is to predict how small molecules, such as drug candidates, bind to a receptor in a known three-dimensional structure. It consists of
two main programs: AutoDock and AutoGrid. AutoGrid pre-calculates a set of grids describing the target protein. AutoDock is responsible for the docking of the ligand to the protein. AutoDock 4.1 employs a graphical user interface, AutoDockTools. This allows the user to modify the ligand before a docking and to visually analyze dockings after completion.

Ligand files in the .mol2 format were first opened in AutoDock for preparation. Once opened, charges were added and all non-polar hydrogen atoms were merged. Next, bonds within the ligand were set as rotatable or fixed. After the root atom of the ligand was detected and all torsions were selected and set, the file was then saved as a .pdbqt file type. (See Appendix G)

The protein file also was prepared for docking. Protein files can be found online at the Protein Data Bank website. The PDB website contains an archive housing information for experimentally determined structures of proteins, nucleic acids and other complex assemblies. Structures can be searched based upon sequence, structure or function. Each molecule can be viewed and downloaded for further analysis. Each structure has a unique four character ID, which can be used to import the structure directly into AutoDock, or the structure file may be downloaded from the website and opened from the saved PDB file. In this project, the 2HTV protein was imported directly into AutoDock. Once the protein file was opened in AutoDock, the excess water molecules were isolated and deleted from the structure. All hydrogen atoms were added to the protein structure. These changes were then saved. The rigid and flexible residues of the protein were selected, and two additional files created; a file_rigid.pbdqt and file_flex.pbdqt. (See Appendix H)
A set of grid maps were constructed, using the AutoGrid function. Both the protein and the appropriate ligand files were chosen for the mapping. A grid box was then used to select which area of the protein structure to be mapped. Ideally this grid box is located at the active site. In situations where the active site of a protein is unknown, it is possible for the grid box to encompass the entire protein, enabling blind docking. Because the active site of the 2HTV protein was unknown, a grid box covering the entire protein structure was implemented. (See Appendix I)

The final step in submitting the docking is to run the AutoDock function. To prepare for this, the rigid protein and ligand files were selected. The Lamarkian genetic algorithm was set up, which controlled the number of scans, the number of mutations, and number of conformations returned. The docking parameters were set, and a docking product file was created. Finally, AutoDock was launched, and the resulting docking conformations were returned in the .dpf file. (See Appendix J)

Genetic algorithms utilize the ideals which are based on the language of natural genetics and biological evolution. When this is applied to molecular docking, the protein and ligand arrangement can be defined by the position of the ligand with respect to the ligands’ translation, orientation and conformation. A fitness parameter is determined, which is the total interaction energy of the ligand with the protein. It is evaluated using the energy function. Offspring (the new ligand-protein structures and energies) of each ligand and protein combination are created. Some offspring undergo mutation, where one gene (a ligand translation, orientation or conformation) changes by a random amount. Selection of the offspring is based on the fitness (its relative energy) which is determined from the resulting structure. Therefore, conformations
with a better fitness are better suited to their environment and as such will survive, while those with poorer fitness do not.\textsuperscript{11}

After the docking completed, the product file was opened for viewing and the returned conformations were analyzed. The conformations are sorted by the software from best to worst, based upon their docked energy. Selecting analyze clusterings allows the user to view the ligand at its docked location, which ideally would be within the active site of the protein. Each resulting set of dockings can be viewed as spheres, to visualize where each of the dockings occurred. Isocontour maps can be created to display the interactions between oxygen atoms in the protein and the ligand. Hydrogen bonding interactions also can be modeled. (See Appendix K)

When analyzing the docking, there are two important points to consider when determining whether a docking is successful or not. The first is if the ligand is within a pocket of the receptor protein. If so, it should be determined whether the pocket is a confirmed active site, if that information is known. How well the ligand fits into the pocket, whether the space is completely filled, or if some alterations to the ligand should be made to better fill the area also should be evaluated. Whether the polar atoms in the ligand are docked near the polar atoms in the receptor protein and the nonpolar atoms in the ligand are near the nonpolar atoms in the protein can be evaluated as well. Interpretation of AutoDock results is open-ended. Much of the analysis depends on chemical insight and creativity to determine the best fit ligand, or what modifications may need to be made to optimize the docking.\textsuperscript{13}

2.5 References

[2] Gaussian 03, Revision D.02,

[5] Finer-Moore, Janet S.; Blaney, Jeff; Stroud, Robert M. Facing the Wall in Computational Based Approaches to Drug Discovery. In Computational and Structural Approaches to Drug Discovery: Ligand-Protein Interactions; Stroud, Robert M.; Finer-Moore, Janet; Royal Society of Chemistry: Cambridge, UK, 2008.
Chapter 3: Results and Conclusion

3.1 Docking

The objective of this research project is to evaluate a library of small molecule ligands to determine their potential antiviral activity against influenza. Twenty-five ligands (see Tables 2.1-2.4) were tested for their ability to bind into an active site of the N4 neuraminidase protein. A blind docking technique was used for this research. This method does not limit the docking site to one small area, but instead gives the possibility of finding the best binding site for the ligand on the entire surface of the protein. Blind docking results in conformations of the ligand bound to multiple sites on the protein, some of which are of interest and some of which are not. The benefit of performing blind docking is to give the ligand more possible sites to bind and not restrict it to one small area on the protein. This technique usually will result in the most stable binding taking place in the active site; however, there is a chance that a more stable docking location may be discovered.
3.2 Ligand Energy Ranking

Five dockings were performed on each of the twenty-five ligands with the protein structure. The dockings returned conformations along with estimations of the docked energy. The docked energy is the sum of the intermolecular energy and internal energy components and is measured in kcal/mol. Lower docked energies result in better fitness ratings in the genetic algorithm. The lowest energy conformations for each of the five trials were compared visually to ensure they were consistent. Their resulting docked energies were averaged to obtain a single docked energy per ligand. The ligands were ordered from lowest to highest docked energy and the relative docked energy was found by comparing the docked energy of each ligand to the 5_hydroxy ligand. (See Table 3.1)

Table 3.1: Ligands Ranked by Increasing Docked Energy

<table>
<thead>
<tr>
<th>Ranking</th>
<th>Ligand</th>
<th>Docked Energy (kcal/mol)</th>
<th>Relative Docked Energy (kcal/mol)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2_nitrogen5</td>
<td>−7.27</td>
<td>−0.46</td>
</tr>
<tr>
<td>2</td>
<td>2_oxygen</td>
<td>−6.93</td>
<td>−0.12</td>
</tr>
<tr>
<td>3</td>
<td>2_methyl</td>
<td>−6.91</td>
<td>−0.10</td>
</tr>
<tr>
<td>4</td>
<td>5_hydroxy</td>
<td>−6.81</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>2_oxygen5</td>
<td>−6.54</td>
<td>0.27</td>
</tr>
<tr>
<td>6</td>
<td>6_methyl</td>
<td>−6.52</td>
<td>0.29</td>
</tr>
<tr>
<td>7</td>
<td>2_hydroxy5</td>
<td>−6.51</td>
<td>0.30</td>
</tr>
<tr>
<td>8</td>
<td>5_chloro</td>
<td>−6.46</td>
<td>0.35</td>
</tr>
<tr>
<td>9</td>
<td>5_methyl</td>
<td>−6.43</td>
<td>0.38</td>
</tr>
<tr>
<td>10</td>
<td>2_nitrogen</td>
<td>−6.38</td>
<td>0.43</td>
</tr>
<tr>
<td>11</td>
<td>6_chloro</td>
<td>−6.38</td>
<td>0.43</td>
</tr>
<tr>
<td>12</td>
<td>5_oxygen</td>
<td>−6.33</td>
<td>0.48</td>
</tr>
</tbody>
</table>
Table 3.1 (cont.): Ligands Ranked by Increasing Docked Energy

<table>
<thead>
<tr>
<th></th>
<th>Ligand</th>
<th>Energy</th>
<th>Sigma</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>5_chloro</td>
<td>−6.32</td>
<td>0.49</td>
</tr>
<tr>
<td>14</td>
<td>6_oxygen</td>
<td>−6.31</td>
<td>0.50</td>
</tr>
<tr>
<td>15</td>
<td>6_nitrogen</td>
<td>−6.28</td>
<td>0.53</td>
</tr>
<tr>
<td>16</td>
<td>5_nitrogen5</td>
<td>−6.27</td>
<td>0.54</td>
</tr>
<tr>
<td>17</td>
<td>2_methyl5</td>
<td>−6.25</td>
<td>0.56</td>
</tr>
<tr>
<td>18</td>
<td>5_oxygen5</td>
<td>−6.24</td>
<td>0.57</td>
</tr>
<tr>
<td>19</td>
<td>2_chloro5</td>
<td>−6.24</td>
<td>0.57</td>
</tr>
<tr>
<td>20</td>
<td>2_chloro</td>
<td>−6.19</td>
<td>0.62</td>
</tr>
<tr>
<td>21</td>
<td>5_hydroxy5</td>
<td>−6.17</td>
<td>0.64</td>
</tr>
<tr>
<td>22</td>
<td>5_methyl5</td>
<td>−6.14</td>
<td>0.67</td>
</tr>
<tr>
<td>23</td>
<td>6_hydroxy</td>
<td>−6.14</td>
<td>0.67</td>
</tr>
<tr>
<td>24</td>
<td>5_nitrogen</td>
<td>−6.06</td>
<td>0.75</td>
</tr>
<tr>
<td>25</td>
<td>2_hydroxy</td>
<td>−5.96</td>
<td>0.85</td>
</tr>
</tbody>
</table>

3.3 Confirmed Antiviral Activity

This results section will focus on only one of the twenty-five ligands, the ligand referred to as 5_hydroxy. This ligand is of particularly high interest because it was synthesized and tested for antiviral activity by Kim, et al.\(^1\) The 5_hydroxy ligand has been shown to have antiviral activity; therefore, it will serve as a reference for comparison with the other ligands. Kim, et.al., tested whether antiviral activity was affected by the placement of the double bond in a six-membered ring. In addition to synthesizing and testing the 5_hydroxy ligand, they synthesized and tested a molecule which was identical to 5_hydroxy but had the double bond positioned to the left of the carboxyl group. It was found that the double bond position does play an important
role in the neuraminidase inhibiting activity, but further structural investigation would be needed in order to illustrate the binding differences of the two compounds within the active site. More important to this project however, is the fact that one of the ligands (5_hydroxy) has been verified to exhibit antiviral activity. Moreover, the lowest energy confirmation returned by AutoDock is consistent with the X-ray crystal structure reported by Kim, et.al.

### 3.4 5_hydroxy results

The 5_hydroxy ligand was the fourth most stable conformation of the group of twenty five ligands that were tested. It binds to the protein with a docked energy of $-6.81$ kcal/mol. The 5_hydroxy ligand fits into a large pocket on the surface of the N4 neuraminidase protein. (See Figure 3.1)

![Figure 3.1](image)

**Figure 3.1**: 5_hydroxy Docked Within N4 Protein

Figure 3.1 displays the docking of the ligand within the N4 protein. The protein is colored by atom type. The red color represents oxygen atoms; the dark blue color represents nitrogen atoms; the grey color represents carbon atoms; and the light
blue color represents the polar hydrogen atoms, those bonded to nitrogen or oxygen atoms. The yellow areas indicate the presence of sulfur atoms. The white spot highlights are shown to give the image the appearance of three-dimensionality. The surface of the protein is not flat; there are many ridges and valleys on the surface. The ligand is shown using a green stick model. The ligand is situated within the deep pocket of the protein. A space filling model better displays the ligand filling the pocket. (See Figure 3.2)

![Figure 3.2: 5_hydroxy Docked with Space Filling Ligand](image)

Figure 3.2 is very similar to Figure 3.1 in nature, but the representation of the ligand has been changed to a space filling model. With this setting, it is possible to see how much of the pocket has been filled by the ligand. There appears to be some empty space remaining slightly behind and to the right of the ligand. Given this remaining space, future ligands could be produced to attempt to fill the entire pocket.
As shown in the figures, there are various pockets on the surface of the protein. Because a blind docking procedure was employed for this analysis, the program determined the most likely site for binding within the protein. Figure 3.3 shows a typical energy conformation diagram of the ten ligand conformations returned by one of the AutoDock runs. The majority of the returned conformations had an energy ranging between $-3.5$ and $-4.0$ kcal/mol. These dockings were on the surface of the protein, outside of the pocket shown in Figures 3.1 and 3.2 where the lowest energy conformation was positioned. The four conformations which had a docked energy around $-5.5$ kcal/mol had the ligand positioned in small pockets, but not in the pocket where the lowest energy conformation was positioned. The lowest energy conformation, $-7.00$ kcal/mol, had the ligand positioned in the pocket on N4 as shown in Figures 3.1 and 3.2. This result is typical of all twenty-five ligands where only one, possibly two, of the returned conformations were within the same pocket as that shown in Figures 3.1 and 3.2.
Upon a closer examination of the docking, it is possible to see the individual interactions between the ligand and protein. Polar protein areas are indeed bound to polar ligand areas. (See Figure 3.4) The dark blue color in this figure represents nitrogen atoms; the red color represents oxygen atoms; the grey color represents carbon atoms; and the light blue color represents polar hydrogen atoms. One can clearly see the hydrogen atom in the carboxyl group of the ligand in close proximity to an oxygen atom on the protein in the upper-right hand corner of the pocket.
Figure 3.4: 5-hydroxy Close-Up Docking with Ball and Stick Model

With another view employing the space-filling feature, it is possible to see how well the ligand fills the pocket of the protein. (See Figure 3.5) The empty space is to the right of the ligand in this perspective.
3.5 Conclusions

Conclusions can be made based upon the results found during computational analysis and the information received from the earlier study of antiviral activity of the same compound. Given that 5_hydroxy showed antiviral activity in the Kim study,\textsuperscript{1} it can be reasoned that all of the compounds in this study also would be potential targets for antiviral activity, with the 2_nitrogen5 ligand giving the best choice to serve as a basic structure in future studies. The 2_nitrogen5 ligand returned the most stable
ligand-protein docked energy of −7.27 kcal/mol. If the docked energy is treated as a change in free energy upon complexation, the difference of −0.46 kcal/mol between the 2_nitrogen5 and 5_hydroxy ligands corresponds to a two-fold increase in the equilibrium constant at 310 K.

One possible direction of future study is to generate many variations on the 2_nitrogen5 structure to find a more stable ligand-protein complex. Another possible study could include moving the position of the double bond within the ring to the left of the carboxyl group for each of the twenty five ligands and testing them to compare the docked energy. This could confirm the previous analysis which indicated that the placement of the double bond was an important variable in ligand-protein complexation. After determining the best position for the double bond, any ligands which had a more stable docked energy than the 5_hydroxy can be altered to accommodate the structural features of the protein binding site.

Based upon the results obtained in this research, the 2_nitrogen5 ligand is the best potential target for further investigative analysis. It had a more stable docked energy than the 5_hydroxy ligand and bound to a large pocket of the N4 protein, which suggests that it could have antiviral activity. A structural search using SciFinder yielded no comparative structures, suggesting that this is a novel lead for a potential new drug discovery.

3.6 References

APPENDIX A

Building a Ligand in GaussView

GaussView is used to build the potential target molecules (or ligands). Upon opening GaussView, a new document will be ready for use. Structures can be created by using a prefabricated backbone structure, found using the ring structure tool, or built completely by hand using the periodic table tool. Once built, molecules can be ‘cleaned up’ by utilizing a molecular mechanics method to approximate appropriate bond lengths, bond angles, and dihedral angles in the structure. Clicking on the small broom icon located on the toolbar will accomplish the clean up. (See Figure A.1)

- Open GaussView and a new document will automatically open
- Using the Periodic Table or Ring tools, insert desired atoms to build a molecule
- Click the small broom icon to clean up the molecule

Figure A.1: Building a Molecule in GaussView
APPENDIX B

Setting Calculation Parameters

Calculations must be set up for the newly created ligand. This is done in GaussView, under the Calculations tab. Gaussian methods are used, and various options are available in the calculation window. There are three basic components to the Gaussian calculations: job type, method, and basis set. Calculations should be performed under the following specifications: job type: optimization; method: ground state, using DFT (density functional theory) B3LYP with a default spin; and basis set: 6-311++G**. A title should be entered under the Title tab. Under the Link 0 tab, %NoSave should be written on the first line and %chk=filename on the second line. All other lines under this tab can be deleted. Once all calculation specifics are entered, the molecule must be saved as a .gjf format file.

- Under Calculations, choose Gaussian, a new window will appear
- Under the Job Type tab, choose Optimization
- Under the Method tab, select Ground State, DFT, Default Spin, B3LYP
- Then select Basis Set as 6-311G, ++, d, p (See Figure B.1)
- Under the Title tab, type the filename followed by opt for optimization: [filename]_opt
- In the Link 0 tab add %NoSave to the first line
- Enter a name for the checkpoint file, if one is not already entered.
- Delete the last two lines
- Select Retain to save settings
- Save the file as a .gjf (See Figure B.2)
Figure B.1: Gaussian Calculation Parameters

Figure B.2: Saving a Molecule in GaussView
APPENDIX C

Transferring Files to the Cluster using WinSCP

WinSCP is a software package that can be used to transfer files to and from the College of Sciences and Humanities Cluster (cluster) and to remotely access the cluster. WinSCP is an open source SFTP and FTP client for Window platforms. Its main function is to securely transfer files between a local computer and remote computer.

- Open WinSCP and login to ccncluster.bsu.edu using your username and password (See Figure C.1)
- In WinSCP window, locate local computer folder containing .gif files (left side) (See Figure C.2)
- Open folder to view files, highlight the files desired for transfer
- Drag the highlighted files into cluster folders (right side) and drop

![WinSCP login Window]

**Figure C1.** Opening WinSCP
Figure C.2: Transferring to Cluster using WinSCP
APPENDIX D

Using PuTTY to access the Cluster

PuTTY is a software package that can be used to transfer files to and from the College of Sciences and Humanities Cluster (cluster) and to remotely access the cluster. PuTTY is an SSH and telnet client. It was originally developed for Windows platform. It is an open-source software which is maintained by a group of volunteers. After each ligand has had the Gaussian calculations set up, the input file then needed to be transferred from the local computer to the cluster. After the files were copied, PuTTY was used to access the cluster. The files were converted from dos to UNIX format. Once converted, they must be submitted to the cluster using the `gtqsub` command so the energy optimization calculations can be performed.

-Open PuTTY and login to ccncluster.bsu.edu using your username and password (See Figure D.1)

- In the PuTTY window, locate the directory containing the `.gif` files

- Convert files to unix using the command: `dos2unix [filename]` (See Figure D.2)

- Submit the calculation to the cluster using the command: `gtqsub [filename] [# of nodes] [time: hh:mm:ss]` (See Figure D.3)

-A reference number for the calculation will appear

![PuTTY Connection Window](image)

**Figure D.1:** Opening Putty
Figure D.2: Converting from dos to unix using PuTTY

Figure D.3: Submitting calculations using PuTTY
APPENDIX E

Transferring Files to the PC using WinSCP

After each calculation is complete, the product file must be copied from the cluster back to the local computer, once again using WinSCP.

- In the WinSCP window, hit the refresh button on the cluster (right) side
- Locate the folder containing the output files
- Highlight the desired files for transfer
- Drag the files to the local computer destination folder and drop (See Figure E.1)

Figure E.1: Transferring to Computer using WinSCP
APPENDIX F

Opening an Output File in GaussView

Once the product files are back on the local computer, the files can be opened in GaussView. From there, changes in the molecule upon optimization are observed. The final step for the first section was to save the product file as a .mol2 file. This will allow the file to be opened in the appropriate program in the next portion of research.

- In GaussView, open output file .log (See Figure F.1)
- View file to note any structural changes
- Resave file as .mol2 file (See Figure F.2)

![Figure F.1: Opening an Output File in GaussView](image)

File type: Gaussian Output file .log
Figure F.2: Saving a .mol2 file in GaussView
APPENDIX G

Preparing a Ligand for AutoDock

Ligand files are opened in AutoDock for preparation. The previously saved .mol2 files are compatible with AutoDock. Charges are added, and all non-polar hydrogens are merged. Next, bonds within the ligand are set as rotatable or fixed. After the root is detected and all torsions are selected and set, the file must be saved as a .pdbqt file type.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Open the ligand:</td>
<td><strong>Ligand</strong> → <strong>Input</strong> → <strong>Open</strong>… Change filetype to .mol2 in dropdown box. Select ligand. Charges will be added and non-polar hydrogen merged if needed. Click <strong>OK</strong></td>
</tr>
<tr>
<td>-Detect the root:</td>
<td><strong>Ligand</strong> → <strong>Torsion Tree</strong> → <strong>Detect Root</strong>… A green sphere will appear (See Figure G.1)</td>
</tr>
<tr>
<td>-Choose torsions:</td>
<td><strong>Ligand</strong> → <strong>Torsion Tree</strong> → <strong>Choose Torsions</strong>… Allows bonds to be selected as rotatable or fixed. Click on purple bonds to activate. Rotatable bonds are green, fixed bonds are red. Click <strong>Done</strong>.</td>
</tr>
<tr>
<td>-Set torsions:</td>
<td><strong>Ligand</strong> → <strong>Torsion Tree</strong> → <strong>Set Number of Torsions</strong>… Choose rotations based upon moving the <strong>fewest atoms</strong> or <strong>most atoms</strong>, as well as the number of torsions allowed. Click <strong>Dismiss</strong>.</td>
</tr>
<tr>
<td>-Save .pdbqt:</td>
<td><strong>Ligand</strong> → <strong>Output</strong> → <strong>Save as PBDQT</strong>… Enter filename.pdbqt to save ligand. Click <strong>Save</strong>.</td>
</tr>
</tbody>
</table>

Figure G.1: Ligand root shown by green sphere
APPENDIX H

Preparing a PDB file for AutoDock

Once a protein file is opened in AutoDock, the excess water molecules should be isolated and deleted from the structure. All hydrogen atoms should be added to the protein structure. These changes must be saved. The rigid and flexible residues of the protein are selected, and two additional files are created: a file_rigid.pbdqt and file_flex.pbdqt.

-Open protein: If file is saved on computer, Right click PMV Molecules. Choose protein file.pbd. Click Open. If file will be downloaded from PDB website, Read → Read Molecule → From Web. Enter PBD code. Click OK.

-Select water: Select → Select from String… In Residue box, type HOH*. In Atom box, type *. Click Add. Click Dismiss. (See Figure H.1)

-Delete water: Edit → Delete → Delete AtomSet… Click Continue.

-Add hydrogens: Edit → Hydrogens → Add… Choose All Hydrogens, method of noBond Order, and yes to renumber. Click OK.

-Resave: File → Save → Write PBD… Type filename.pbd. Write ATOM and HETATM records. Choose Sort Nodes. Click OK. (See Figure H.2)

-Choose macromolecule: Flexible Residues → Input → Choose Macromolecule… Select protein. Click Select Molecule. Click Yes to merge non-polar hydrogens. Click OK.

-Select flexible residues: Select → Select From String… Click Clear Form. Enter desired flexible residue in the Residue field and click Add. Click Dismiss.

-Choose torsions: Flexible Residues → Choose Torsions in Currently Selected Residues… Click on a desired bond to inactivate it. Click Close. Clear selection using the Pencil Eraser icon.

-Save flexible file: Flexible Residues → Output → Save Flexible PBDQT… Enter filename_flex.pbdqt.

-Save rigid file: Flexible Residues → Output → Save Rigid PDBQT… Enter filename_rigid.pbdqt.

-Remove molecule: Edit → Delete → Delete Molecule… Select protein and click Delete Molecule. Click Continue. Click Dismiss.
Figure H.1: Removing water from macromolecule

Figure H.2: Saving PDB file
APPENDIX I

Running AutoGrid

A grid map must be set up, using AutoGrid. Both the protein and the appropriate ligand files are chosen. A grid box is used to select which area of the protein structure to be mapped. This grid box ideally is positioned in order to include the active site within its boundaries. When the active site of a protein is unknown, this grid box can encompass the entire protein. A grid parameter file (.gpf) needs to be created. Then, AutoGrid can be run.

-Preparing macromolecule for grid: **Grid → Macromolecule → Open**… Choose filename _rigid.pbdqt_. Click **Open**. Click **Yes** to preserve the input charges. Click **OK** to warning boxes.

-Set map types: **Grid → Set Map Types → Choose/Open Ligand**… Choose/open ligand file.

-Set grid box: **Grid → Grid Box**… Using the thumbwheels, position the grid box over the active site of the protein. If the active site is unknown, the grid box can encompass the entire protein. Record the grid settings to make this step easier in the future. Save grid by clicking **File → Close Saving Current**. (See Figure I.1)

-Save GPF: **Grid → Output → Save GPF**… Save grid parameter file as _filename.gpf_.

-Running AutoGrid: **Run → Run AutoGrid**… Verify filenames and click **Launch**.
Figure I.1: Grid box
APPENDIX J

Running AutoDock

The final step in submitting the docking is to run AutoDock. To set up this procedure, the rigid protein and ligand files are selected. The genetic algorithm is set up, which controls the number of scans, the number of mutations, and number of conformations returned. The docking parameters are set, and a docking product file is created. AutoDock is launched, and the resulting docking conformations are returned in the .dpf file.

| -Selecting rigid file: Docking ➔ Macromolecule ➔ Set Rigid Filename… Select filename_rigid.pdbqt. Click Open. |
| -Select ligand: Docking ➔ Ligand ➔ Choose… Click on ligand. Click Select Ligand. |
| -Select flexible file: Docking ➔ Macromolecule ➔ Set Flexible Residue filename… Select filename_flexible.pdbqt. Click Open. |
| -Set algorithm parameters: Docking ➔ Search Parameters ➔ Genetic Algorithm… Do initial runs using the short setting. Click Accept. |
| -Set docking parameters: Docking ➔ Docking Parameters… Use defaults. Click Close. |
| -Create DPF: Docking ➔ Output ➔ Lamarckian GA… Enter filename.dpf. Click Save. |
| -Running AutoDock: Run ➔ Run AutoDock… Verify filenames and click Launch. |
APPENDIX K

Analyzing Docking Results

After the docking is completed, the product file will be opened for viewing. After opening the product file, the returned conformations are analyzed. By opening clusterings, the ligand is viewed at its docked location. Each resulting set of dockings can be viewed as spheres, to visualize where each of the dockings occurred.

Isocontour maps can be created to display the interactions between the oxygen atoms in the protein and the ligand. Hydrogen bonding interactions can also be modeled.

- Open results: Analyze → Dockings → Open… Open the file.dlg
- Opening conformations: Analyze → Conformations → Load… Opens Conformation Chooser, displaying energies and clusters of the results, ranked from best to worst based upon lowest energy in cluster and best individual per cluster. (See Figure K.1)
- Analyzing results: Analyze → Clusterings → Open… Associations between ligand and receptor can be viewed (See Figure K.2)
- Review all docking sites: Analyze → Dockings → Show as Spheres… Each docked conformation is shown as a sphere (See Figure K.3)
- Viewing hydrogen bonding: Analyze → Dockings → Show Interactions… Alters the display to show interactions between ligand and receptor (See Figure K.4)

---

**Figure K.1:** Conformation Chooser
Figure K.2: Docked Ligand

Figure K.3: Dockings shown as spheres
Figure K.4: Interactions between docking site and ligand
APPENDIX L

Images of Dockings

Images for each ligand showing interactions between the ligand and active site of the protein. The ligand is shown in the molecular space fill cloud. The binding sites interacting from the protein are also shown, with the amino acids which interact with the ligand labeled. Images are shown from lowest energy ligands to highest.

Figure L.1: 2_nitrogen5 interactions
Figure L.2: 2_oxygen interactions
Figure 3.L: 2-methyl interactions
Figure L.4: 5_hydroxy interactions
Figure L.5: 2_oxygen5 interactions
Figure L.6: 6_methyl interactions
Figure L.7: 2_hydroxy5 interactions
Figure L.8: 5_chloro interactions
Figure L.9: 5-methyl interactions
Figure L.10: 2_nitrogen interactions
Figure L.11: 6_chloro interactions
Figure L.12: 5_oxygen interactions
Figure L.13: 5_chloro5 interactions
Figure L.14: 6_oxygen interactions
Figure L.15: 6_nitrogen interactions
Figure L.16: 5_nitrogen5 interactions
Figure L.17: 2_methyl5 interactions
Figure L.18: 5_oxygen5 interactions
Figure L.19: 2_chloro5 interactions
Figure L.20: 2_chloro interactions
Figure L.21: 5-hydroxy5 interactions
Figure L.22: 5_methyl5 interactions
Figure L.23: 6_hydroxy interactions
Figure L.24: 5_nitrogen interactions
Figure L.25: 2_hydroxy interactions